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File > Employee Maintenance = Main

| M v2.03e(2] - MasterLink - 997 OUR PAYROLL SERY - 2003 |_ [O] <]

Eile Input Beports Swestem  Tranzmit Help

M Employee Maintenance [_ [O] x|

] CdpiMisc | Auto Trans | SiciaciExpt | Fed Totals | State Totals | Human Resources

Emp Mo |1 IKENT, CLARKE I Site # I

88N {001-01-001 1 | SOMEWHERE WiAY LIP NORTH Salary
Spf“a'ﬂ‘ City, State Zip  [COLOVILLE, NP 85454 [2111.00

Matital Exempt  Addl  Withheld
Status Allow  Amtor % State  State Ratas Johs Distr
R -l = | vr #1[24 358 [02-01-08 |40
state w12 [0 | [ca #1| [0z-02-04 [10
#3| [0z-0205 5 %
DateuinreIDﬂDHgs HnurIyDrSalawls vl #4| |02—DB—D4 |45 %
Date quastRaiseIDQIE']IQS Pay Periods peryear | 24 #5| | | Yo
Hours Perwieek (Tnot 40y [ #5| [ | %

™ Elirn rate & salary on listing Wark Location Code I

ext | Erey | Eind | Qeletel Add | Frint | Quit |

Employee Number - System assigned next available number. May be user assigned
when Adding new employee.

Social Security Number

LAST NAME, FIRST NAME MI (CAPS)
City, State Zip Code

Site Number — Time Clock interface reference

Special Seq — Four (4) character text field prints to the right of the employee’s name
in the check envelope window for sorting/distribution purposes

Salary - Annualized amount divided by the number of pay periods. Salary will also
be annualized automatically and divided by 2080 or the equivalent Hours per Week
(if not 40) to establish Rate #1. Rate #1 is used to calculate Sic/Vac earnings, etc.
Salaries may be automatically split over multiple departments by percentages.
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Federal Withholding Status — S (Single) M (Married) H (Head of Household) Blank
(Exempt) From Employee provided W4 (See W4 form and Instructions) Or the IRS
web page at http://www.irs.gov/formspubs/index.html

State Withholding S (Single) M (Married) H (Head of Household) Blank (Exempt)
From Employee provided State Withholding Certificate (See State Web Page Index at
http://www.taxadmin.org/fta/ftafact1.html)

Rates Each employee can have up to six (6) regular rates of pay. Regular rates of
pay are automatically assigned for salaried employees by annualizing the salary and
dividing by 2080 or the number of regular hours if not 40 in Hours Per Week (if not
40) box. Transaction codes use rates of pay to calculate earnings. Regular rates of
pay may be split over multiple departments by percentage automatically if a “/ “is
used in the input (see input). Rate #1 for salaried employees is generally used for
calculating Sic/Vac earnings, etc. Rate #1 is generally used by transaction codes to
calculate overtime, sick, vacation, holiday, etc. earnings.

Jobs (see also Job Codes) Also called home departments in the employee file, are
created and stored in the Job Codes section. They are three (3) sets of two (2) digits
(e.g. XX-XX-XX). Digits may be alpha or numerical. Job numbers may be used in
any combination and to any level (e.g. XX-XX-XX, XX-XX, XX). If the job is not
keyed during input and there is a department in the employee file all of that
employee’s earnings will automatically be assigned to that home department for that
pay period.

Dist Salaries will be distributed across multiple departments by percentages.
Protocol is XX where X is a number between 0 and 9 with no “%”. Rates may be
distributed by percentage automatically by using a “/” during input (see Input). Rates
are not entered after Rate #1 for automatic distribution.

Date of Hire — Used for Sic/Vac calculations,

Date of Last Raise

Hourly or Salary

Pay Periods per Year - Used for the calculation of Federal and State personal income
tax withholding and for calculating hourly wage for salaried employees.

Hours Per Week (if not 40) -Used to calculate regular hours for salaried employees
that work less than 40 hours per week or 2080hours annually.

Elim rate and Salary on Listing — If selected will block rates and salaries on the
employee listing. Overrides security parameters in Security; also blocks access to
some employee information in Employee screens.

Work Location Code — Applicable only for Oregon employees
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Next — next Employee

Prev — Previous Employee

Find — Find Employee (EE) by Last Name, EE # or Social Security Number (SSN)
Delete — Delete Employee. May only be used when there is no Year To Date for EE
Add — Add New Employee.

Print — Print Employee File

Quit — Quit Employee File

File > Employee Maintenance - Ddp/Misc

a
rg

FLYIMG SUPERHERD

15 YULNERABLE TO KRYFTOMITE

o |

Direct Deposit —
Check ID —
ABA No. - 9 digit bank routing number for employee direct deposit.

Account — Employee bank account number for direct deposit
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Date Terminated — printed on the Employee Listing/Worksheet. Used also by the
Sic/Vac program, etc.

Next Review Date — printed on the Employee Listing/Worksheet.

Ag Info — for agricultural employees subject to Federal 943 reporting rules and State
overtime provisions.

Linked Emp — For employees subject to both Federal 943 and 941 reporting rules.

Certified -
Comments - Text fields; printed on the last line of the Employee Listing/Worksheet.

Deemed equivalent wages — Nevada Worker’s Compensation field for non-wage earners

Allow short with tips — For employees that receive cash tips and are taxed as an “In and
Out” earning.  Will allow the employee to accumulate negative earnings until tax
liability is met. Specifically will deduct amount for Social Security and Medicare first,
then Federal and State withholding.

Short — Amount of negative earnings accumulated when net earnings are not available to
withhold taxes.
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File > Employee Maintenance

->Sic/Vac/Expt

M V2 03e[8) - MasterLink - 997 OUR PAYROLL SERY - 2003 - |O] x|
File Input Beports  Sestem Transmit  Help

M Employee Maintenance O] =]

Main | Ddpihlisc | Auto Trans SichaciExpt | Fed Totals | State Totals | Human Resources

Emp Mo |1 IKENT, CLARKE Il

Sick Vacation Comp Time —

sen| Units e =] | sen| units [Time <]
Beq. Balance |4D Beg. Balance IEE.UU I 0.00 Exempt

Az of Date I 01/0100 Az of Date I a1401/00 I N I- fFEdErEl Gruss

| % of Rate | |_ % of Rate |_21 9178 Gur. Balance F EE
Ii

Limit Limnit | | 0.00 I EIGA Eaid

Mew Rate Eff. Date Mew Rate Eff. Date = | LS Paid
| | 1 | | i IV | GiateGross
| | T | | I, I~ | CAST

= crem
| [ | E I~ casul
| | 1 | I = |CAETT

Apply To I I” Bl Excess I I” Bl Excess

DateofBal [ o7i2i01 | | AllowNeg [0zi0m03 | [ Allowhieg
Current Bal I 16.00 I 24117

et | Prev | Find | Qeletel Add | Print Quit

The field parameters for Sick and Vacation are identical

Sch — Company wide policy for appropriate benefit. If the schedule under Global
Sic/Vac is utilized, will calculate Sic or Vac for employees within appropriate group by
placing the schedule number in the Sch field. See Global Sic/VVac Rules under File.
Also see the Sick and Vacation Setup section

Example: Company A has a Sick/Vacation policy that states that all hourly
employees will accrue 8 hours of sick time over their first year beginning on the first day
of the fourth month of employee’s regular employment and will accrue 40 hours of
Vacation time over their first year beginning on the first day of the fourth month of
employee’s regular employment. One year after becoming eligible for Sic/VVacation
benefits, the employee will accrue 16 hours of sick time and 64 hours of vacation over
the second benefit year.

Units — Drop down menu
- Time — Accrual based on days, annualized (e.g. 40 hours / 365 days)
- Hour - Accrual based on actual hours worked
- Gross — Rate 1 multiplied by number of hours accrued
- Exclude — Excludes employee from Sic/Vac report, the employee’s check and
all other areas
- DrawDown — Set amount of hours available to employee instead of accruing

6
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- Empty — Stops accrual for employee that has previously accrued Sic/Vac and
leaves balances

Beg. Balance — Amount of hours available when Sic/Vac accrual is begun or available as
draw down

As of Date — Date that Beg. Balance is established

[ 1% of rate — Will force the calculation of accrual as a percentage of the accrual rate.
E.g. full time employees accrue at 100% of [rate] while half time employees accrue at
50% of [rate]. If the % of rate is changed while the employee has already accrued hours,
the sic/vac report will recalculate the available balance based on the new percentage.

Rate — accrual rate. Expressed as a decimal (e.g. 40/2080 = 0.019230 = 1 week per year
accrued hours)

New Rate — Employee’s future rate as of a particular date

Eff. Date — Date New Rate is to take effect
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Company

OUR PAYROLL SERY

OUR PAYROLL SERY Tied to

EVERY DAY IS PAYDAY Transaction

il st Code (9) meal
calculation.
Based on state
regs.

Tax Deposit
Frequency

Common Name — DBA

Name 1 — Legal name used by I.R.S. and State agencies. Sole proprietors and
partnerships use principal’s names. S-corps, C-Corps and L.L.C.’s use legal name of
entity as shown on SS4 and/or the First line of the 941

Name 2 — Second line on 941 and State Tax forms, et al.

Contact — Client authorized contact person for payroll information.



MasterLink user guide

File > Company - Report Groups

M Company Info

Company Info

Fayday Reports |

Reparts

Repart Graups

Maonthly Reports

| Repart Defaults

| Quartetly Repors

Reports for Payday

I [=] 5

Input Report

Attendance Report

Income Register
Deduction Register

Check Register

Fayroll Register

Labor Gross --= Total
Labor Hours --= Gross
Labor Gross --= Met
Employee Listing
Employee History Repaort
Sick & Wacation Repart
Workman's Compensation Report
Cerdified Payroll Report
Tax Report

Employee Changes Report

Attendance Report
Deduction Register
FPayroll Register

Labor Hours --= Gross
Employee History Repart
Certified Payroll Report

-

Delete Report |

Quit |

Setup for printing Payday, Monthly and Quarterly reports. Once selected will print
automatically when the Payday Reports, Monthly Reports or Quarterly Reports are

selected from the Reports menu.



MasterLink user guide

File > Company - Report Defaults — Selections for print parameters.

REGHRE OTHRES WAC HRS SICHRS MISC§

Title — the “~" before the “|” will create boxes in the Employee Listing/Worksheet.

10
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File > Check Calculator

Check Calcutator

Find by | & Marme  © Number | Pay Period
|KENT, CLARKE Il j e I_D' ISemi-Montth 'l
Marital Exempt Addl  Withheld Current YTD

Status

Federal Is 'i E

Allow  Amtor % State

ol Gross | 1245.33 | sera.40

Cafeteria 0.00
State IM vi [1_3 IE calr .

State & Local Taxes

Dizahle Federal ™ | 51.42

401K 0.00 4D1Ki %

™ Posted

[ 39038
Check# |
. i Fica | 7721 | 383 84
|‘\E§— meci [ 1808 [ ears
Beg Per il
End Per | i s 1211 I a9 52
Cthtel T S0 [ 11z [ sz
Auto Trans | -74.72
Input Ded 0.00
Saved Checks Met Pay lm‘

| v] print | Prichk| clear | peiete | save | oun |

1. Employee Drag Down

2. Annual Gross

3. Pay Period
Employee file.

4. Fed/State Withholding

Select Employee by Alpha or Employee Number

Enter amount. Calculator will automatically complete gross
to net by selected pay period

Automatically defaults to pay period established in
Manual override for special calculations

Automatically defaults to Federal and State Withholding in
Employee file. Manual override for special calculations

Additional Allowances

Withheld Amount or %
Overrides by percentage or dollar amount or
automatically adds additional amount to calculation
based on employee file (All default Federal
calculations are based on Schedule E, Publication
15 Type two [%] calculations)

11
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5. Gross

6. Cafeteria

7. 401(K)

8. Federal

9. FICA

10. Medi

State 1D
Home state for calculation of employee personal
state and local (other than CASDI) income tax.
Defaults to State ID in Employee file. Required
field

Enter Amount. For salaried employees automatically
defaults to per pay period salary. Check calculator
automatically calculates gross to net, including adjustments
for any amounts in employee auto transactions (employee
file).

To complete calculation, double click on gross amount
(required) to pop-up input screen.

P el i

a

1add || Zins | @oel | 0

PCodes | 4-Clear Quit |

Enter amount. Pre tax section 125 or equivalent
transaction. Amount is treated as non-taxable deduction or
negative earning

Enter amount or percentage. 401(K) or similar transaction,
exempt from Federal and State personal income tax.

Defaults to calculation of Federal personal income tax
withheld based on amount in employee file or is overridden
by amount or percent entered in (4) above. Also may be
overridden in pop-up input screen (See input, Check
calculator — Tips).

Automatic calculation of employee FICA (OASDI)
liability. Amount cannot be overridden. Puttinga “v"™ in
the box will force FICA to be not calculated.

Automatic calculation of employee Medicare liability.
Cannot be overridden.

12
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11. SWT Defaults to calculation of State personal income tax
withheld based on amount in employee file or is overridden
by amount or percent entered in (4) above. Also may be
overridden in pop up input screen. Also dependent on State

1D

12. Auto Trans Defaults to automatic transactions se
Overridden by clicking on [

box next to selected auto-trans.

t up in employee file.

4box, place “v in

M Automatic Transactions, Deductions =10] x|
Disahle |Tcode [Transaction Quan  JAmount FPar &
™ 241401 (Ka% ooaf &
~
=
I~
—
=
~
~
=
[ -

Total 0.00

Transz Codes |

May also be overridden in pop up input screen by typing
transaction code without multiplier amount * (see
transaction codes, input)

E— ] B

Jo1-01-01 010104
1-80 010101
010 0
[Ergai] 2ine | 3Del | [ 100000
PCodes | 4-Clear | Gt |

13
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* Example — typing “24” by itself blocks transaction code 24

13. Input Ded Displays and calculates net amount based on deductions
input in pop up input screen.

14. Net Pay Amount automatically calculated based on parameters
selected in  <1-13> above or enter amount to calculate
gross to net.

Gross Up

15. Gross Up Automatically calculates gross pay based on amount
entered in [net pay] and based on parameters selected in
<1-14> above when [Gross Up] button clicked.

et Pay 0.00

!

16. Posted f this box is checked the calculated check has been posted
to input and saved. Available for later review under drop
down menu <saved Checks>. **** File saved as as
{usr/detdbf/mdt-company#.dbf.  See File Structure, Check
Detail, Error Messages, Input

\ __ - | Comment: File saved as as

7 Ahanl 4T Cuetam marmaratad mavt avrmilalla ~henl mimahar  KMavs ke Jusr/detdbf/mdt-company#.dbf.  See File
17. Check # System generat_ed next a_val_lable c_heck number. May be Structure, Check Detail, Error Messages,
manually overridden to indicate different account or Input

sequence number (see manual check calculation — TIPS).
Check number posted in new Input when imported and
shown on check register as memo field

18. Beg Period Beginning date of pay period of check calculation. Will be
imported into input screen with new input and shown on
check register as memo field. Also stored in check detail
file.

19. End Per End date of pay period of check calculation. Will be
imported into input screen with new input and shown on
check register as memo field. Also stored in check detail
file.

20. Chk Dte Check date of pay period of check calculation. Will be
imported into input screen with new input and shown on
check register as memo field. Also stored in check detail
file.

21. Saved Checks Drop down selection of previously saved and/or posted
check calculations.

14
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22. Print

23. Prt Chk

Print manual check to screen and/or plain paper check stub
. May be net $ amount or net $ zero if manual check is
calculated and paid from different account (see manual
check calculation — TIPS, Input). Check must be <saved>
before printing.

Print manual check in regular check format. May be net $
amount or net $ zero if manual check is calculated and paid
from different account (see manual check calculation —
TIPS). Check must be <saved> before printing.

15
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File > GL Journal

ik — 9t =10l x|
Syskem  Transmit Help
_|O] x|
Job Level I 3
Seq GIL Mumber Cescription DbiCr | Type Joh Mmbr o
1530(1 M 0202100 [METROPOLIS CATCHING BAD GUYS Taxes Paid D |STATE3 010202
15840(1010202100 [METROFOLIS CATCHIMG BAD GUYS Taxes Paid D |STATEZ 010202
1850(1 010202100  [METROFOLIS CATCHIMG BAD GUYS Taxes Paid O |STATE4 010202 ,_l
1860(1010202100  [METROPOLIS CATCHIMG BAD GIUYS Taxes Paid O |STATE4 010202
1870(1010202100  [METROPOLIS CATCHIMG BAD GUYS Taxes Paid D |STATE4 010202
1680(1020000001 SMALLVILLE REGULAR TIME D [AMOUNT (02
1580(1020000002  [SMALLVILLE 1 142 TIME D [AMOUNT (02
1600[1020000004  |SMALLVILLE SICK TIME D [amounT oz
1610[1020000006  |[SMALLVILLE YACATION D [amounT Joz
1620[1020000007  [SMALLVILLE SALARY D [amounT Joz
1630[1020000012  |SMALLVILLE HRS X RATE D [amounT Joz
1640[1020000015  [SMALLVILLE COMMISSIONS D [amounT o2
1650(1020000027  [SMALLVILLE COMP D [AMOUNT (02
1660(1020000100  [SMALLVILLE Taxes Paid O |[FICAP 0z
1670({1020000100  [SMALLVILLE Taxes FPaid O |[FICAP 0z
1680(1020000100  [SMALLVILLE Taxes Paid O |MEDCF 0z
1630{1020000100  [SMALLVILLE Taxes Paid D [FUTA 02 il
Save Restore GIL Setup Order Eind Erint Export it
NOTE: THE GL FILE MUST BE SET UP AT THE SERVICE BUREAU
BEFORE BEING RUN IN MASTERLINK. PLEASE CALL YOUR
PAYROLL PROCESSOR FOR DETAILS.
In general, if the Service Bureau offers custom General Ledger reporting
and export/import services the Service Bureau should create the initial
modified/custom file. Advanced users may decide to create, edit and
maintain the G.L. file. Please contact the Service Bureau for details. (See
also File Structure, Update Custom Report Data)
Elements
Seq Sequence Number — designates the order by which the GL account

numbers are sorted.

16
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G/L Number System generated. May be changed to accommodate user’s GL Chart of
Accounts.

System generated GL numbers are assigned as follows:

JOB LEVEL #DIGITS

0 4
1 6
2 8
3 10

All the G.L. numbers that do not start with a 1 have zeros added to give the number of
digits listed above.

job number and tt is the transaction code number, xx is a two digit number
corresponding to which record this state holds in the state tax file to generate a unique
GL number for each state):

DEBITS:

2tt0000000 Non-Tax Reimb.
CREDITS:

30tt000000 Deductions.
4000000000 Cash in Bank.
5000000000 Federal Withheld
5100000000 FICA Withheld
5200000000 Medicare With.
5300000000 FICA Emp. Paid.
5400000000 Medicare Paid.
5500000000 Federal Unempl.
6xx0000000 State tax 1
6xx1000000 State tax 2
6xx2000000 State tax 3
6xx3000000 State tax 4
6xx4000000 Workers' Comp.
6xx5000000 Trans type A
DEBITS:

7000000000 Tax Impounds
8000000000 Fed Tax Dep.
9000000000 State Tax Dep.

17
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Description  Text description of the job code associated with each line item.
Descriptions can be found in File = Job Codes

Db/Cr Debit or Credit designator

Type Transaction type description. From Check Detail file. The General
Ledger database holds one record for every possible type of pay, tax,
deduction and job based on the data generated when payrolls have been
processed. The transaction types are as follows:

FWT  Federal Withholding

NETCHK Net Amt less taxes

FICAW FICA Withheld

AMOUNT Gross amount

MEDCW Medicare Withheld

FICAP FICA Employer Paid

MEDCP Medicare Employer Paid

FUTA FUTA Employer Paid

STATEL1 (defined by state tax file) in California, PIT
STATE?2 (California) DI

STATE3 (California) Ul

STATE4 (California) ETT

+F941-FWT Fed Withholding amount in Tax Deposit (F943 for ag.)
+F941-FICAW FICA Withheld amount in Tax Deposit
+F941-MEDCW Medicare Withheld amount in Tax Deposit
+F941-FICAP FICA Paid amount in Tax Deposit
+F941-MEDCP Medicare Paid amount in Tax Deposit
+F940-FUTA FUTA Paid amount in Tax Deposit
+DEB88-STATEX State tax amount in Tax Deposit

+TAX -FWT Fed Withholding amount in Tax Impound
+TAX -FICAW FICA Withholding amount Tax Impound
+TAX -MEDCW Medicare Withheld amount in Tax Impound
+TAX -FICAP FICA Paid amount in Tax Impound

+TAX -MEDCP Medicare Paid amount in Tax Impound
+TAX -FUTA Paid amount in Tax Impound

+TAX -STATEX State tax amount in Tax Impound

Job Nmbr Job number associated with line item. Called from the check detail file.
Save Saves the gln.dbf file
Restore Restores the gln.dbf file to the last saved version

G/L Setup Setup options for printing or establishing the parameters for exporting the
GL report

18
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I G
o
in
i
u

L
-

=

Order Sort order based on the various elements of the GL raw file.

Find Search for any specific line item by element in the GL raw file.

19
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Print Print the GL report or chart of accounts by selected date ranges

0B09/03 10 | 0B/09/03

20
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Export Export GL report as readable database to file
M ¥2.03e(12) - MasterLink - 937 OURE, =10l =]
File Input FReports  System  Transmit  Help
x =10/
File Mame Job Level I a
[causricusTOMGL CoV Dot [rpe o b I;I
i I~ Toawera o |
File Type
ey oo TR 2
Comma Delirr = = 3
¥ Combine ¢ Look i = & & cf B
Begin En 12345.xls allergies. C0% ] checkreq.dbf comper
|uar09m:3 ta IUEIDE [€]52481990.08F  [E] allergies.DEF checkreq.bxt [] comper
activ,CD¥ attn.CDi chk-292,DEF depern.!
— | quit | |Eactiv.0EF (=] attn.DEF (=] chi-997.08F ] depen.|
i 2 1P ada.con B charack.CDx B cobpme. O B deti-2¢
%] ada.0EF [&] charact.0BF [&] cabpmt DEF (=] det1-z¢
100{1000000100  |Employer F
110{1000000100  |EmplayerF [ 4] | o
120(1000000100  |Employer F _
130]7000000700  |EmployerF E*PeitFie  falesy &I
1401000000100 _[EmpIoyer P joq of ype: [ Fies (-9 = Cancel_|
14001000000100  |Employer F
160]1000000100  |Employer F Help |
1701000000100  |Employer F
Cade Page.. |
Save Restore | GiL

Process: 1. Select File Type

2. Name File and Path
-> To open select (open) dialog box click on the box

- Select path and file name in the drag down menu
R s W

Look, in: I 5 custom

—> Type or select file name in theExport File box.

Export File |glexpurtfile.csv

=

NOTE: Select All Files (*.*) to see all available file names and options

Files of type: IAII Files [*.7]

21
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File = Import Time

M v2.03e[12] - MasterLink -

File Input FReportz  Swstem

997 OUR PAYROLL SERY - 2003
Tranzmit Help

Tranzaction Types

Employee Mumber

<] _aau | Import Format |

=0l x|

=10l x|

Employes MName

Deleta | Field Description Field Mame |Len |Order

Job Code

g = 0=

Fate for Amt X Amt

Time Clock Pay Type

Job Code = =

REGLULAR TIME ENTER HRS 8= o=

Time Clock Pay Amount

REGILAR TIME EMTER HRS

11/2 TIME ENTER HRS g =] o =

1102 TME ENTER HRZ

CASH TIPS ==

RATE 2

SICH TIME RATE1

»|

HOLID A RATE 1

WACATION RATE 1

SALARY

CASHTIPS

Code

MEALS

— Translation

WAGES PAID AMT.

Tahle

DOUBLE TME  RATE 1

Format

-

HRS ¥ RATE EXE

j Clear Format Sort Fields Delete

CAZSH ADWANCE

Field |

BORUS

COMMIZSIONS

RATE 3

Irmpart File IC:\USRICUSTOMITIMEIMF'ORT.}{LS

MIZC REMBURSEMENT

= File Type SDF % ghuwlmpl 1mpur1|

]

Quit |

Elements

Transaction Types

Add

Delete

Field Description

Transaction codes used by MasterLink to calculate payroll.

Note: Rate for Amt X Amt, Time Clock Pay Type and
Time Clock Pay Amount are reserved for use with
time clock interfaces in conjunction with the Code
Translation Table.

Add new import format
Note — this is NOT for adding transaction types to the
format table

Delete current import format

Transaction type added to format. If no order set will
correspond to the order of data to be imported.

22
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Len Field length - used for columnar imports.
Order Forces the imported data order over the line position
Spc When designated with a “D” divides the imported data by

100. E.g - some data capturing devices do not use
decimals for dollar amounts so the amount 1000 would
translate to 10.00 and 1010 would translate to 10.10

Code Translation Translates time clock text transaction codes to
Table correlating MasterLink numeric transaction codes. E.g.
Reg (regular) = 1, ovt (overtime) = 2, Sal (salary) =7

Format Drop down menu containing saved formats. Select
appropriate format for specific import file

49 | |mport Format  [impon

Delete | Field Description Fleld Mame |[Len |Order |Spl=
Employvee Mumhber 4 :j ] j 2
Emplovee Mame 1] :i 0 j F
Job Code s o |-
REGULAR TIME ENTER HRS == ==K
1112 TIME ENTER HRS 3= = E
i‘ Rate for Amt % Amt = = E
Tirne Clock Pay Type = =
Time Clock Pay Amount 2_—2_! Dﬁ -
Code
Translation
Tahle
Format o

| v[ Clear Format SortFields Delste Field |

impunz

Impaort File !C:lUSRICUSTOMWIMEIMF’ORT.}{LS l
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Open EE3
Lok, in: IE]USH j e ¥ EB-
_IEMPOEE [ import ] ) ptmdbf Clsavemp
| IFONTS 1 uPoEF Clooicer Clsetup
[ 1Fox (1 J0BDEE (1 qpeper I sandbf
" aindhf [ lgodb [ opaper [ 15T=DEF
| |HRIDEF [ pavoer Clgpaner [ svddbr
| impdbf [ PAYREMOT (repkxt [ TA%DEF
Kl | i3
Impart File | Ok, I
Files of type: I,-’.\II Files === ut) L‘ Cancel |

Help |
Eode Fage:. |

Import File File to be imported into MasterLink. Click on the to

display the open file dialog box.

Sort Fields Sorts import fields

Delete Field Deletes specific import field

Clear Format
Show Imp

Import

Clears entire import format
Shows entire import file

Import file

24



MasterLink user guide

File > Global Sic/Vac Rules

M Global Sic & Yac Rules o ] |
Schedule #|
Sick Vacation——————
Heading I Type - Headingl Type IEmpt\,r vl
# ofHours  Starting After #ofHours  Starting After
Fervear # of Months Per Year # of Months
Apply To | “Apply To |
[ Exclude 0T T Allow Meg Balance [T Exclude 0T [ Allow Meg Balance
Balance Limit I Balance Limit I
hax HrsfPay Period | Max HrsiPay Periudl
* 0 Feaular. 1 Owverdime. 2 Holiday, 3 Sick, 4 Yacation * [0 Reoular. 1 Owerdime. 2 Holiday, 3 Sick, 4 Yacation
5 heals, 6 Tips, 7 Other 5 Meals, 6 Tips, 7 Other
et Erew Delete Add Quit
Elements

The field parameters for Sick and Vacation are identical

Company wide policy for appropriate benefit. If the schedule under Global
Sic/Vac is utilized, will calculate Sic or Vac for employees within appropriate
group by placing the schedule number in the Sch field.

See File > Employee - Sic/Vac/Exmpt.

Schedule # - Company can have an unlimited number of Sick/Vacation
schedules. The Schedule # is set in employee screen Sic/Vac/Expt

Heading — Text qualifier for Sick/Vacation schedule. Changes heading on
Sic/Vac report.

Type — Accrual basis.

Hour — accrues based on actual hours worked

Time — accrues on time based on 365 days. E.g — 2080 hours per year
/ 365 days =

Gross — Accrual based on per pay period gross
25
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Exclude — excludes all transaction types from accrual
Dollar — Accrues a matched dollar amount

# of Hours Per Year — Number of hours employee will accrue

Starting after # Month — Month accrual begins

*Appy to — Transaction code type to which accruals will be applied

Exclude OT — Do not include any OT transaction types for Sick/Vac accruals

Allow Neg Balance — will allow all employees with schedule to take more Sick or
Vacation hours than accrued.

Balance Limit — Schedule-wide limit. Includes current year, annual roll over
limit. In general, the total number of hours individual employees will be able to
accrue and carry over to new year if not used.

Problem: If, for example, an Agricultural employee is able to work 60
regular hours per week, that employee may accrue more than 40 hours if
that employee were to take time off within the current year.

Max Hrs/Pay Period — Maximum number of hours employees’ accrual will be
based on. Used to stop accrual for employees that work other than 40 regular
hours in a work week.
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Example 1: Company A has a Sick/Vacation policy that states that all
hourly employees will accrue 8 hours of sick time over their first year
beginning on the first day of the fourth month of employee’s regular
employment and will accrue 40 hours of Vacation time over their first
year beginning on the first day of the fourth month of employee’s regular
employment. One year after becoming eligible for Sic/Vacation benefits,
the employee will accrue 16 hours of sick time and 64 hours of vacation
over the second benefit year.

-1oix|
Schedule #| 1
Sick Vacation————

Heading |sickte}ct Type IHDur 'I Heading |vactexﬂ Type IEmI:Jt‘jr 'l

# ofHours  Starting After # of Hours  Stadting After

Fervear # of Months Ferear # of Months

IB |3 40 |3

I'IE |12 |E4 |12

*Apply To |E1234 *Apply Ta I

[T Exclude 0T T Allow Meg Balance [T Exclude 0T I Allow Meg Balance

Balance Limit I Balance Lirmnit I
Max Hrs/Pay Period I Max HrsiPay Period I

*0 Reaular. 1 Overime. 2 Holiday, 3 Sick, 4 Yacation *0 Reaular. 1 Overlime. 2 Holiday, 3 Sick, 4 Yacation
5 Meals, B Tips, 7 Other 5 Meals, B Tips, 7 Other

et Prey Delete | Add | Quit
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Input

M v2.03e(12) - MasterLink - 997 OUR PAYROLL SERY - 2003 =10l x|

Filz | Input Reports  System  Transmit  Help

Currenk
Briar
Mew

MasterlLink:

PAYROLL AND HRIS SO0FTWARE

@ 2001 PayMaster Inc.

PAYROLL MASTERS

Where Every Day is Papday™

www.PayrollMasters.com

Current — Open a previously begun input file

Prior — Open a previously sent input file
M select Input

01421403
0B/09/03
0B/ /02
061 0403
07119102
12/0302
1ot =l

FEind | Qeletel it |

Each time a new payroll input is begun MasterLink prompts the user to save the
previous input to a file.

*Note — when transmitting files to the service bureau, the only files sent are the
input file (c:\usninpdbf\inp.dbf) and the employee file (c:\usr\empdbf\emp[year]-
[company number].dbf (e.g. emp3-997.dbf)) unless the Send G/L file and/or
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Send HR Data options are selected under Modem Setup in Transmit (see Transmit
- Modem Setup)

New — Begins a new input file to be transmitted to the service bureau.

Once Input = New is selected user will be prompted to save previous
input to a file

M save Input File x|

Save Current Input
to

| 08f18i03

(u]:4 | Cancel -

And warned that the current input will be cleared

EE— x|
|| E Warning Current input will be clearedil!
L

(04 I Cancel |

If manual checks have been calculated and saved during the pay period,
user will be prompted

EE—— x|
] Manual checks Found waiting to be added ko Input
] OF to add them Mow

Cancel |
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When [OK] selected, manual checks are displayed before being posted to
input

M Imported Manual Checks ] x|

F4 EMPLOYEE, JAME D
1-40.00

2-5.00

F8.75

50.00

h2

.

mame
0a/19/03Man addtomput | quit |

*NOTE - Imported Manual Checks file must be named before being
posted to input.
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New Input Elements

M v2.03e{12) - MasterLink - 997 OUR PAYROLL SERY - 2003

File Input FReports Swstem  Transmit  Help
| TRANSACTION CODES |
Code |Descripti0n |;
1 REGLILAR: TIME ENTER HRS
2 1142 TIME ENTER HRS
3 RATE 2
4 SICK TIME ~ RATE 1
5 HOLID&Y RATE 1
g VACATION  RATEA1
7 SALARY
g CASH TIPS
] MEALS
10 WAGESPAD  AMT.
11 DOUBLE TIME  RATE 1 .
12 HRSXRATE EXE
13 CASH ADVANCE
14 BONLS
5 COMMISSIONS
16 RATE 3
17 MISC REIMBLIRSEMENT
18 TRAVEL EXPENSE REMBLR 2
Employee Info
[ | KENT CLARKE Il
Dept Salary Rate Distr
[oz0108  |z11100 Jaa3s8 |40

IDE-DE-IM
|02-02-05

[ o
—

o

Auto Trans |24

[ra =
v

= || =
wils

ma L
=1 L
(= sk

Add Sal

(in}
=)
=

Job Set

Motes

Print

Add Imp
Add Man

it bRl

Quit

o ] 4|
1011
[ Last Payroll ofithe WMokt
Petiod Begin. g a3
Petiod Ending 08418603
Date of Check e ama
Payroll Input |‘-'°b# =

Period Begin
Period Ending
Date of Check

Add

Ins

Del

Find

Add Sal

Sort

Job Set

Notes

Print

Job

Add Imp

Add Man

Del Imp/Man
Transaction Codes
Employee Infor
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Payroll Input

Period Begin — Begin date of payroll period
Period Ending — End date of payroll period
Date of Check — Payroll check date.

NOTE

Check date is the date used for MOST reporting, payroll calculations and
correspondence with Federal and State agencies.

The service bureau may have restrictions on direct deposit dates and/or
holiday, weekend paydays, etc. It is EXTREMELY important that the
user check with the service bureau regarding any restrictions on
availability of funds

There are very specific Federal and State rules regarding payroll check
dates. For example, in California employers are generally required to pay
all of its employees at least Semi-monthly. Please confirm with the
appropriate agencies or call your payroll processor or service bureau agent
for more details.

=
1
>
a
o

10 [ER ST Ay T T T Add

. . e e
Petind Bedir. 0ar1 a3 Mode
Fetiod Ending e emns

Diate of Check 0areimns

Payrall Input |._Inb# =
| «—

When selected, places the input screen in Add mode. Indicated by =

(e ) sl Ll e
= |2 = 1=
=5 il s

Once the period begin, ending and check dates are entered the input system
automatically goes into add mode when the [Enter] button is hit twice.

2.-Ins — Inserts a line directly above the line the cursor is on

3.-Del — Deletes the line the cursor is on
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Find - Find employee in input file. By number or by name.

' by Mumber O by Mame

Add Sal — Automatically adds all salaried employees that are active (no date in
File> Employee - DDP/Misc - Date Terminated).

M add salaried Employees to Inpuk } = II:Ilﬂ
FPost [Emp# |[Emplovee Bame Salary l;
=2 I | KEMT, CLARKE I 2111.00
v |2 LAME, LOIS 45000
v |6 O'COMMER, SANDRA D, 2083.33
Post it

By default all active salaried employees are selected. To stop an employee’s salary

from being automatically posted, uncheck the box next to the employee’s name in the
(Post) column.

*Note — One time salary changes may be made by entering a n amount in the
Salary column that corresponds to the employee.

Once the appropriate employees have been selected, click the __Bost | pytton.
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E

L] E Posting Complete
L

Import file is confirmed with the notice.

Sort function — used when a single employee has multiple lines of input to
combine all those to one paycheck.

Example:

Fayrall Input Joh¥# =~
1-16.00 020106
1-4.00 020204
1-2.00 020205
1-18.00 020304
F3 EMPLOYEE, JOHM Q.

1-40

F3 EMPLOYEE, JOHEM Gl

1-40

F3 EMPLOYEE, JOHRM Gl

1-40

Employee #3 has 3 lines of earnings data entered (3X40 regular hours); When the
sort button is select, all of employee’s earnings are sorted to one paycheck

NOTE: the input system will warn that the input is about to be sorted

Microsoft Visual FoxPro |
9P

7
‘-—'f) Are you sure woul wank bo sork?

(o] 4 | Cancel I

Once the file has been sorted, all the earnings for each unique employee will be
grouped together
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Pawroll Input |.J0b# x
P3  EMPLOYEE JOHM Q. [ o1
1-40 01
1-40 01
1-40 01

When the payroll is processed, the employee will receive only one check.

NOTE - normally if there are multiple lines of employee earnings separated by
the employee number the employee will receive multiple checks.

Example:

Payroll Input |.an# I;:
P3 EMPLOYEE, JOHR G Il o

1-40 o

1-40 o

1-40 o

P3  EMPLOYEE, JOHR G Il o

1-40 o

2-5 o

As inputted this employee would receive a check for 120 regular hours (1-40,1-
40,1-40) and a second check for 40 regular and 5 overtime hours (1-40, 2-5)

TIP — Normally manual checks are entered (or imported) in the input first. When
using the Sort function it is REQUIRED that manual checks are entered at the
end of the input. The reason for this is that any employee that has multiple lines

of input before sorting, including manual checks, will have all of their earning
combined.
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Example:

Payrall Input |._Inb# I:J

F3 EMPLOYEE, JOHE Gl nj|

1-10.00 01

23-25.00

Fo.0o

S0.00

T 1

F3 EMPLOYEE, JOHM .11 01

1-40 o1

25 o1

P32 EMPLOYEE, JOHM 2. I 0

1-40 01

F4 EMPLOYEE, JANE D o

1-40 01

F3 EMPLOYEE, JOHM 2. I o

1-40 01
I

Employee 3 has one manual check entered and 120 regular hours with 5 overtime
hours. Employee 4 has 40 regular hours. If this input were processed without
sorting employee 3 would receive four (4) SEPERAT E checks; the manual
check, a check for 40 regular and 5 overtime hours, a check for 40 regular hours,
and a fourth check for 40 regular hours

Example (continued)

Payroll Input |.Job# I:_,
P3 EMPLOYEE JOHM Q. Il [o1
1-10.00 0
23-25.00

F0.00

50.00

h1

1-40 0
2-5 0
1-40 o
1-40 o
F4 EMFLOYEE, JANE D, oM
1-40 oM
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Once the payroll has been sorted, however, employee 3 would receive one (1) check
that includes the manual check, 120 regular hours and 5 overtime hours.

Job Set — When Job Set is selected, all input data is coded to the job# directly
above the line of data selected overriding all home departments in the employee

file or conversely setting the job to the employee file. The input defaults to the
employee file.

Job set is most often used when crews of employees are performing groups of
specific tasks, such as agricultural employees harvesting crops.

Example:

Payrall Input Job# |~
F3 EMPLOYEE, JOHRM Gl o

1-40 o

P& SIXPAGQ PHREDERIGE L. 04

1-40 04

P& BRAWK, WILLIAKM D. 0z

1-40 0z

P10 GRAY, TOM 1c]

1-40 03

Employees 3, 5, 8 and 20 have job numbers 01, 04, 02, and 03 set as their home
departments in their respective employee file.
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This is indicated in the lower left corner of the Input System and in the Employee

File under File(See Input System > Employee info, and File > Employee >
Main)
Employee Info-
[z |EMPLOYEE. JOHM Q.11
Dept Salary Fate Cistr
—

| [11.00

|
==
|

11

Auto Trans |23

When Job Set is selected, the job in the employee file is overridden and all input
coded to the input job.

Pavroll Input |.J0b# =
P3 EMPLOYEE, JOHR G (1l 01

JBT-87 BTET

1-40 BTET

PS5 SIHPAG, PHREDERIGE L. BTET

1-40 BTET

PE  BRAWHN, WILLIAM D a7a7

1-40 a7a7

P10 GRAY, TOM B7a7

1-40 avar
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Notes — text file

EE— ol x]
Notes

Iaksdesldfskdﬂ slkfas lsadif Isdjf aslkdf] aslkdif a d=al asljasdkl saljkfl ﬂ
aslif sfikjsdf sladkf Isaf olsoadflsa dfas f

Quit |
Print — Prints the input file with gross calculations exactly as keyed
CONVERSION OF DATA ENTERED
RUN DATE: 19-AUGUST-03 OUR PAYROLL SERV TINE:

CHECKS TO BE DATED
----DATA A5 INPUT-----

P3 EWPLOYEE, JOHN 0.

111

FOR THE PAY PERIOD
cvossusat io st CRESULT OF EONVERSTONS 25w Loz soossunne

ERPLOYEE 3 EWPLOYEE, JOHN Q. III HOME DEPARTMENT 01
J87-87 JOB NUMBER 87-87
1-40 TXN CODE 1 REGULAR TINE 40.00 @ 11000 JOB 87-87
P5 SIXPAQ, PHREDERIQE L.

ENPLOYEE 5 SI){PMI PHREDERIOE L. HOME DEPARTHENT 04
1-40 TXN CODE REGULAR TINE 40.00 @ 10.000 JOB 87-87
P8 BRAWN, WILLIAN D.

ERPLOYEE 8 BRAWN, WILLIAM D. HOWE DEPARTHENT 02
1-40 TXN CODE 1 REGULAR TINE 40.00 @ 10.000 JOB 87-87
PO  GRAY, TOM

EMPLOYEE 10 GRAY, TOM HOME DEPARTHENT 03
1-40 TXN CODE 1 REGULAR TIME 40.00 B 8. 500 JOB 87-87
* THERE ARE 31 LINES OF DATA AND 4 CHECKS ENTERED. i

* TOTAL TXN CODE 1 REGULAR TIME

160000 :

T2 E2: 32342 2223223222222 222 2L A2 AT RS A2 RIS EEL AR 2R LR IR AIRLRE

39
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Job — Opens the Job File. (See File > Job Codes)

Add Imp - Adds data imported in the Import Time file (see File > Import time)

Add Man - Adds manual checks previously saved in the Check Calculator (see File >

Check Calculator).

Del Imp/Man - Deletes imported file by file name.

M ¥2.03e{12) - MasterLink - 997 OUR PAYROLL SERY - 2003

File Input Reports Swstem  Transmit  Help
| TRAMSACTION CODES |
Code [Description [«]
1 REGLULAR TIME EMTER HRS
& 112 TIME ENTER HRZ
3 RATE 2
4 SICK TIME RATE 1
a HOLIDAY RATE 1
G SACATION RATEA1
7 SALARY
g CASH TIPS
9 MEALS
10 WWAGES PAIC AMT.
11 DioUBLE TIME  RATE 1 Ere
12 HRES X RATE EXE
13 CASH ADYANCE
14 BONUS
15 COMMISSIONS
16 RATE 3
17 MISC REMBURSEMENT
18 TRANEL EXPENSE REMBLUR it
Employee Info
— ] | KENT. CLARKE Il
Cept Salany Rate Distr
[ozo1os J211100  [z4258 40
I 02-02-04 I I 10
I 02-02-05 I I a
Auta Trans | 24

1-Add |
2-lns |
2-Digl |
Eind |

Add Sal |

Sort |

Joh Set

_Job Get |
MNotes |
Erint |

Job |

Add lImp I
Add Man |
Del 1mpIMan|

Quit

=100l
o ] 4
I Last Payroll ofthe Maonth
Period Begin. banamnz
FPeriod Ending e a3
Date of Check 0gi1ern3
Payrall Input |an# -

Employee - Auto Trans screen.

40

TRANSACTION CODES - Scrolling accessible file Double clicking on
the transaction codes fields pops up the transaction code file. Allows the
user to quickly jump between the input file and the transaction code file.

Employee Info — Accessible informational file. Clicking anywhere in the
Employee info box pops up the employee file for editing.

— *Note - Employee Auto Trans identifies the transaction codes in File >
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Input Basics

Keystrokes

Employee
Job Number

Trans Code

Split Qualifier

Split Qualifier
Across multiple departments

Change Beginning
Pay Period

Change End
Pay Period

Block All
Direct Deposit

Change Dollar Amount
Transaction to Percentage

Change Percentage Amount
Transaction to Dollar

l 1

p period
* J
#(1) “-“#(2) Where #(1) is the
transaction code (Earnings/ Deductions)
number, followed by a dash (“-*) and #(2) is
an amount
E.g. 01, 01-01, 01-01-01

/

[+

Beg

End

%
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Beginning a New Payroll

1. Enter Period Begin, Period Ending and Date on Check

2. Enter first Employee to be paid. To input an employee, type a period “.” and the

employee number

i s A S—— -
R F'erfud Eleg?n. 09/21i03 Made J-Add Feriod Begin. 08/21/03 Mode
e Feriod Ending 0giz1103 _1 Fetiod Ending 08214032
= Date of Check 08121403 2ol Date of Check |UBJ'21IE|3
2-[el 3-Del I
Find Payroll Input |J0b# = Find Payroll Input |.J0b# &~
_find_| 3 I | _find_| P3 EMPLOYEE, JOHN QI o
Add Sal | Add Sal | l
Once the employee has been entered, the employee information is displayed in the
lower left corner of the Input Screen
Ermployee Info
|3 |EMPLOYEE. JOHM . 1l
Dept Salary Rate Distr
—> | [o1 | [1100 ]
Auto Transg |23
3. Enter job code; Key “*” followed by job number. Job numbers are three
(3) sets of two (2) numbers separated by dashes (-)
| =i = e (R R e =R R Al
Petiod Bedin. 0er21m3 Peri -
1-Add _ : CEEULC. | eriod Begin. 05/21/03 Maode
Zins_| reriod Bndling ] 08121103 = Period Ending | narz1/03
;—Del Date of Check  [namima Zlre Dateof Check  [paztio
—|— 2-Del
: Fayrall Input |.J0b# |:_| - e
Eind | 7 Fayroll Input |Jub#
L lg;m‘s _End | e LovEE JoRa T o
Add Sal | agd sl | J05-05-05 lusnsns

*NOTE - if no job is keyed, the earnings and deductions for the

employee will default to those “home departments” set in the
employee file (See File>Employee—>Main)
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4. Enter earnings and Deductions; Earnings and Deductions are entered by
keying a transaction code (#1) followed by a dash (-) then an amount (#2).

QI-[]EI I | |UU.'1_I.'U.J |
Find I FPayroll Input |.an# I;
= P3  EMPLOYEE, JOHM 1. Il 01
J05-05-05 050505
T ECH G Pt 050505
:r 2-5 050505
S0t |

Job Set

*NOTE - Transaction codes are displayed in the upper right quadrant of
the input system

| TRAMSACTION CODES |

Code |Descriptinn 5
REGULAR TIME EMTER HRS

11/2 TME ENMTER HR=

RATE 2

SICK TIME RATE 1

HOLIDAY RATE 1

Lan s Tk T oA

T s L b —

In this example — the employee is paid 40 regular hours and 5 overtime
hours and those hours are coded to job 05-05-05

TIP — there are two circumstances when the transaction code is NOT
followed by a dash (-) and an amount

A To pay a salaried employee their regular salary (transaction
code 7)
B. To BLOCK an automatic transaction.

Transaction codes are multipliers; therefore an employee’s
salary — which is always transaction code #7, is the salary

X 1.
= 2-5 050505
—_Df| F3 SMNIFES, JAMES 03
Jobset | |7 03

Motes | |
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Pa SNIPES, JAMES

EHPLOYEE 9 SNIPES, JAWES HOME DEPARTHENT 03

T TI  .. 11, .
* THERE ARE 12 LINES OF DATA AND 2 CHECKS ENTERED. .
+ TOTAL DN GODE 1 REGULAR TIKE 40 00D .
+ TOTAL DN CODE 2 1 172 TIHE 5000 .
+ TOTAL XN CODE 7 SALARY 1500_000 .

Input Gross & Deductions

Pay Code Gross Deductions Motes

1500_00 Jo0

Check# Emp# MName

2 3 EMPLOYEE, JOHN Q. Il

GARMESHMENT % 13063
REGULAR TIME EMTER HRS 44000
112 TIME ENTER HRS 82.50

Check Total 52250 130 63

Check# Emp# MName

3 B SNIPES, JAMES
SALARY 1500.00

Check Total 150000 o.oo

Every other type of transaction code requires an amount for the
transaction code to be multiplied by, and therefore a transaction
code NOT followed by a (-) and an amount is assumed to be
multiplied by zero (0).

Pavroll Input |.an# I_;|
P3 EMPLOYEE, JOHK G, 11l o
J05-05-05 050505
1-40 050505
2-5 050505
——————————> |13 050505
|

Employee Info

[z |EMPLOYEE JoHN G I
Dept Salary Rate Distr

[01 | {11.00 |
r [
r '

Auto Trans |23
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----DATA AS INPUT----- fme-eee——-coo—— - -RESULT OF CONVERSTOM--------cooooooooooo

P3 EWPLOYEE, JOHN Q. III
EHPLOYEE 3 EWPLOYEE, Jl]Hg Q. IIT HOME DEPARTHENT 01

J05-05-05 JOB NUBER 05-05-0

1-10 TXN GODE 1 REGULAR TINE 4000 @ 11000 JOB 05-05-05
2.5 TXNCODE 2 11/2 TIHE _ 5.00 8 16.500 JOB 05-05-05
5 I—————————————————— .- s, S L R

* THERE ARE 14 LINES OF DATA AND 1 GHECKS ENTERED. .

+ TOTAL XN GODE 1  REGULAR TIME 40 000 .

* TOTAL TN CODE 2 1 1/2 TIHE 5.000 5

2R ITEIILET L IR I LR 2L 2RI R L LRI R LEE AR IR R LEL R ELE

Input Gross & Deductions

FPay Code Gross Deductions MNotes

Check# Emp# MName

2 3 EMPLOYEE, JOHN Q. 1l

REGULAR TIME EMTER HRS 440100
112 TIME ENTER HRS 8260
GARMSHMENT %
Check Total 522460 0.0o

Salary Input — Enter employee followed by transaction code (7)

=T I e 050505
Jaoh Set | F3 EMIPES, JAMES o3
Motes I 7| |

Print I

Employee Info
s [sniPEs James

Dept Salary Rate Distr
e | 1500 [17.308 |
[ [—
[ [/ —

Auto Trans |

Example 1: Employee Snipes, James is paid salary by keying “.” 9 then
[Enter] and transaction code (7). Since no job code was entered all
earnings and deductions will be coded to employee’s home department
(03). This employee has no automatic transactions.
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Note: Employee’s Rate (Rate 1) is calculated automatically by

annualizing the salary based in the number of pay periods in the Employee

File and dividing by 2080 (1500 X 24 / 2080).

Example 2:

F1  KEMT, CLARKE Il 020106

7 |

Employee Info-

!DE—DQ—EM
!02-02-05

K | KENT. cLARKE NI
Cept Salary Rate Distr
[oz-01-06  [211100 [24388  [4p

]

[ [
—

Auto Trans |24

Employee 1 Kent, Clarke is paid Salary (7). Inthe Employee File the

employee’s salary is distributed across multiple departments automatically

(Job 02-01-06: 40%, Job 02-02-04: 10%, Job 02-02-05: 5%, and 02-03-

04: 45%). To see the detail click on the Employee Info in the bottom left

corner of the input system. When transaction code (7) is entered and the
[Enter] key hit, the salary is automatically distributed.

F1  KENT, CLARKE Il 020106

7-844.40 020106

21110 020204

7-1056.55 020205

l 7-940.95 020304
|

transaction (24) automatically applied; in this case a 401(k) transaction for 6% of

the employee’s gross.

Employee will also have

Emp Mo [ | KENT, CLARKE Il
Codel|Description Amount (Limit Month|Mtd "r'td
24 401 (k)% b.0% 12000 744 .78

k= | H
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Check # Emp# MName

41 KEMT, CLARKE IIl
A01 (K)% 126 66
SALARY 844.40
SALARY 211.10
SALARY 10555
SALARY 94995
Check Total 211100 126 66
P1 KENT, CLARKE III
EHWPLOYEE 1 KENT, CLARKE III HOME DEPARTHENT 02-01-06
7-844_40 TXN CODE 7 SALARY 644 40 JOB 02-D1-D6
7-211_10 TXN CODE 7 SALARY 211.10 JOB 02-D2-D4
7-105_55 TXN CODE 7 SALARY 105.55 .JOB 02-D2-D5
Ko DRSO -...5 " SRR, . ol 949.95 0B 02-03-04
Split Qualifier “/” and Split Qualifier across multiple transactions and/or departments
Ll/+!l
Inputting Salary with Sick or Vacation time — When a salaried employee takes
accrued time off (\Vacation, Sick, PTO, ETO, Etc.) MasterLink can automatically

calculate the adjusted salary.

Example 1:

F3 SHIFES, JAMES 03
7 03
B-8/ |

P9 SMIPES, JAMES 03

7-1361.54 03

£-2.00 03
|

Employee (9) Snipes, James has taken 8 hours of Vacation time. After the

employee’s salary is keyed, the transaction code for vacation is keye

line followed by a dash and the number of hours followed by the “/”.

d on the next
When

[Enter] is hit, MasterLink recalculates the employee’s salary by multiplying 8
hours by the employee’s regular rate of pay then automatically subtracting that

amount from the salary.
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Employee Info

[ IsniPEs James

Diept Salary Rate Diistr
e [1500 [17308 |
I [ [
] [ (I
Auto Trans I

Salary 1500 — 138.46 Vacation (8 hours X 17.308) = 138.464

Check # Emp# Mame

5 9 SNIPES, JAMES

SALARY 1361 54
WACATION — RATE 1 13846
Check Total 150000 ooa

Example 2: All the above remain the same but additionally Employee Snipes has taken 8
hours of Sick time (Transaction Code 4).

PO SMIPES, JAMES 03

7-1361 54 03

B-5.00 03

45 | |
PH  SMIPES, JAMES o3
7-1223.08 o3
B-5.00 o3
4-5.00 03

|

The Employee’s salary is again adjusted by 138.46 so the gross remains 1500

Check# Emp# MName

5 8 SNIPES, JAMES

SALARY 122308
WACATION RATE 1 138.46
SICK TIME RATE1 138.46
Check Total 1800.00 ooo
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Example 3: Employee 1 Kent, Clarke’s salary is automatically split between 4
departments and employee takes 8 hours of accrued Vacation time.

Pl KENT, SLARKE [l fE01 06

7-644.40 020106

7-211.10 f20204

7-105.55 020205

7-848.95 020304

B0/ | |
Pl KENT, CLARKE I 020106
7-6449.54 F201 06
7-211.10 020204
7-105.55 020205
7-848.95 020304
B-3.00 020106

As in Example 2 above, Employee is paid salary and 8 hours of Vacation time followed
by the “/”” switch. Notice however that in this case the employee’s salary is ONLY
adjusted at the first department.

M KENT, CLARKE III

EWPLOYEE 1 KENT, CLARKE III HOME DEPARTHMENT 02-01-06
7-649.54 TXN CODE 7 SAL. 649.54 JOB 02-01-06
7-211.10 TXN CODE 7 SALARY 211.10 JOB 02-02-04
7-105.55 TXN CODE 7 SALARY 105.55 JOB 02-02-05
7-949.95 TXN CODE 7 SALARY 949.95 J0OB 02-03-04
6-8.00 TXN CODE 6 VACATION g.00 @ 24_358 JOB 02-01-06
Check # Emp# Mame
4 1 KENT, CLARKE 11l

401 (k)% 126.66

SALARY 549 54

SALARY 211.10

SALARY 105 55

SALARY 94005

WACATION RATE 1 194 86

Check Total 2111.00 126 66

If however the 6-8/ is followed by a “+” the vacation amount will be split by the same
percentages and to the same departments as the Salary
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As in the previous example when the employee also has taken 8 hours of Sick Time
(Transaction code 4) and is keyed as 4-8/+ the salary SPLITS are again adjusted.
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Change Beginning/End Pay Period - BEG/END

During a payroll input the pay period may be adjusted within the current pay period to
accommodate multiple pay periods. For example — some companies pay their hourly
employees weekly and their salaried employees bi-weekly.

Note: If multiple pay periods are used within the same input the Check
Date will remain the same for all checks.

—————————— TR
Petiod Bedin, 0821/03 <[ Wode
Petiod Ending 032103 <
Date of Check Iugmma

Payroll Input |J°b# =

24-100% sl

P2 LANE, LOIS o2

24-100% ik

BEG 0815 <

END 08/20 <

Fd SHIPES, JAMES o3

7 03

I

Block all Direct Deposits N

To block ALL direct deposits in a payroll enter an “N” on the first line of input.

. - ————————— Al
Period Begin. 08/21/03 Mode

FPeriod Ending 09/15/03

Date of Check 092003

Payrall Input |._I|:|b# \;I
N |

: - ——————————— ]
1 pdld Feriod Begin. 0321503 Mode
= Period Ending 091 5m3

21ns Date of Gheck  [parzomz
2=[el

— Payrall Input |ng# =

= NO DIRECT DEPOSIT

|
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Change Dollar amount transaction to Percentage and Percentage transaction amount to
Dollar amount - %,$

Forced switch between Dollar and Percentage automatic
transaction codes in input.

Transaction code followed by a “-“ then amount and “$” or “%”

Example: Employee has transaction code 24 (401(k) %) set in
employee file automatic transaction codes with 3% of gross

M Employee Maintenance 5 |I:||£|
| Siciac/Expt I Fed Totals | State Totals | Human Fesources

ein | Dopiisc | AutoTrans

Emp o |3 | LanE, Lais

Codel|Desctription Amount [Limit Month|Mtd “rtd #
24 401 (K)% 30X 12000 8569

—_

Ermployee Info

[z |LawE Lois
Dept Salary Fate Diistr

[0z 45000 [1z2500 [0

10 N
— ) [ [

Auto Trans |24

P2z LANE, LOIS 02
24-100% |

During payroll input employee’s 401(k) amount is forced to $100.00

NOTE: If employee’s auto transaction amount is forced in input it
is imperative that the same transaction code is used so the limit set
in the employee’s auto transaction field is calculated (In this
example the limit is set at $12,000).

To force a dollar amount to a percentage substitute “%” with “$”

P2 LANE, LOIS Wl
EWPLOYEE 2 LANE, LOIS HOME DEPARTMENT 02

24-100% TN CODE 24 401 (K)% 100.00 .JoB 02
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Check # Emp# Marme

5 2 LAME, LOIS
401 (KI%

100.00

Check Total 0oo
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System

M ¥2.03(7) - MasterLink - 997 OUR PAYROLL SERY - 2003

File Input Reports | System  Transmit  Help

Encryption key

Reindex

Backup

Reskore

Restore Old Emp File
Change System Year
Default Comparry
Cuskom

Security

Printer Setup

Save ko Disk Interval
Edit Time Punch
Update Custom Repart Data

PAYROLL MASTERS

Where Every Day is Papday™

= [ |
terlink:
[D HR 1S SOFTWARE
£
&
g
@

www.PayrollMasters.com

Reindex
Backup
Restore

Restore Old Emp File
Change System Year

Default Company
Custom

Security

Printer Setup

Save to Disk Interval

Edit Time Punch

Update Custom Report Data

Encryption Key

Reindex

MasterLink makes use of multiple databases at the same time. To do this all of the

databases must have an index order set.

To set the index order select System - Reindex.
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When finished, MasterLink displays
e

ITTUERITIY WULIET 5

Indexing Quarter 4

Indexing ¥TD

Indexing Tax

Indexing Transaction Codes
Indexing Detz

Indexing Joks: 2 ]
Indexing Stat I l I I S e
Indexing Inpu

Indexing Mod

Indexing Company List
Indexing

Indexing Company Glohal
Indexing GL

Indexing Sig File = T
Indexing Loga File ¢ Quit
Reopening Files

Select L A to continue.
Note: MasterLink may be Reindexed at any time. This is the most common way
to correct any errors that may occur.

Backup - Creates copy of all databases to selected drive
Restore — Restores databases from selected source

Restore Old Emp File - When payroll has been received MasterLink creates a backup of
the employee file before it is overwritten by the received file.

Note: When MasterLink files are transmitted (Transmit - Send Input) to the
service bureau only the input file (inp(companynumber).dbf) and the employee
file (emp(year)-(companynumber.dbf) are sent; When Input - Receive Payroll is
selected all of the company’s database files are received and updated in
MasterLink and the received employee file becomes live data. In the event that
that the files received overwrite the most current file in MasterLink, by selecting
Restore Old Emp File will revert the employee file to the most current version
residing locally.

Example: Client has entered a new employee in MasterLink on Monday.
On Tuesday Client asks service bureau to change a Manual Check that
occurred after the payroll was received for the last pay period. Service
Bureau makes appropriate changes to the payroll and asks client to receive
files. If the Client receives files before sending input to the service
bureau, the employee file from the LAST payroll period would over write
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the current files on Client’s computer. Therefore the new employee
entered on Monday would need to be RE-Entered.

Note: This can be avoided by selecting Transmit - Send Input
BEFORE receiving updated files. Please contact your service
bureau payroll processor before proceeding.

Change System Year - MasterLink will store as many vyears of payroll data as the
client has processed payrolls with the service bureau. MasterLink normally would
remain in the current year, however to run reports for previous years and/or to
review employee data from previous years the system must be changed to the
appropriate year.

=1l

Systern Tear
2

QK | it |

If the year does not yet exist in MasterLink, user will be prompted to receive data

Masterlink

PAYROLL AND HRIS SOFTWARE

L cronge systemveor ST | =y

_XJ
&?/ Diata does not exist Far this vear, Setup for recieve data

Cancel |

Guuit |

]
2001 PayMaster Inc.

PAYROLL MASTERS
Whare Evary Day is Payday™

wwww.PayrollMasters.com

Once data has been received the status bar and employee file will indicate the year the

system is in and that the system is not in the current year
M ¥2.03/(7) - MasterLink - 997 OUR PAYROLL SERY - 2002 = o ]

File Input Reports Swstem  Transmit Help
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M Employee Maintenance e ;IEILI

Ddpidisc | Auta Trans | SicifacExpt | Fed Totals | State Totals | Human Resources

001-01-0011

EMT, CLARKE Il

SOMEVHERE YAy UP NORTH

COLDVILLE, NP 85454

Warning Warning Yarning j x|

harital EBExempt Ad

Status Allc ' . :
Federal IM i I 4 3: ; 'E Masterlink Year is nok Current Year
State Mo = 1
e [T
Date oinre'm;m;gs HULIFWDrSaIaWIS j
Date DfLaﬁRa\SElugmrgs Pay Petiods per Yeat | 24

Date ofElirthI s Hours PerWeek(ifnoHD)l

ext | Frev | Find | Qeletel Add | Print | it |

Note: The Employee file is year dependant. Any changes made in a previous
year will not translate to the current year.

Default Company - Sets the company that is opened when MasterLink is opened. If
there are multiple companies MasterLink will open the default with the master password
and/or the password assigned to the user or the company (see security).

Custom — custom settings.
-Ioix]

Auto Input Order

Mame 'l

Custom Report Data Location

Ic:\usncustoml

Temp File Location

Open Mew Data

Data Location

Auto Input order — allows user to select either Alpha or Department for posting salaries
automatically in Input (see Input)

Custom Report Data Location — Path to which all the custom report databases are saved.
Data Location — Path to set network application data files.

Temp File Location — forces MasterLink to look for report temp files in a specific
directory other than the default directory.
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Printer Setup — Print parameters

x4
i+ Landscape . Portrait‘

—Check Micr Locatian

Top Check |1530

Faorm Lenath W Hotiaat L hek |31 80

Check Sig Location —Check Name Location——

#-Pos |152|j Line
Y¥-Pos |11|j|j Caolumn

[T HF Laserjetll [ InkJetiLaser

Save to Disk Interval
i Flush Memory Buffers tolDi oy ] |

Every I | 1 Minutes
it |

Edit Time Punch

_ioix
O Lunch " Dec Time
e " 5td Time
Emp # I I
Start Time End Tirme
Wiark Date I I I ; I
Prev | Find | add | Detete | Prnt | quit |

Manually edit time card punches to print on check stubs. Very infrequently used, works
in conjunction with the import time function.

Encryption Key — Encryption key is the secret code used to un-encrypt transmitted files.
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Warning Warning Warning Warning Yarning = ﬂ

L] E Do Mok Change Key Unless Instructed to By the Payroll Center
L

M Encryption Key ! ~=1ol x|

ey

Save &Exit Cancel

Note: Do not change key unless instructed to by Service Bureau
Update Custom Report Data — Manually save custom report databases to a folder (usually

c:\usr\custom). Forces the most recent changes in MasterLink to be reflected in the
custom databases.
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File Structure
= SR

File Edt View Favorites Toos  Help

Q=-0-F

/' ) Search |{-* Folders

Address [ ciusR

Hame_+

Size | Type

| Date Modified

] Edso | Norton anevius 1 -

File and Folder Tasks

2 Maks 3 riew Folder
&) Publish this folder to the
web

k! Share this Falder

Other Places a

< Local Disk (C:)
1) My Dacuments
[ shared Documerts
i My Computer
€ My Hetwork Places

Details £

(CptmdF
[E)GD10BF
(Cycpzper

[)¥TDDBF

& company.Bak
= company .CO%

=0 company.oeF

[ companr.FeT
= company.Tex

= ddp-hold, dbf
Elvico

=] MSCREATE.DIR:
[peunzip EXE
[Fprzip exE

o cEallH
[Fsetupz BAT
Fueravico

Chgdbf — Employee change file. Chg(year)-company#.dbf

2KB
5KB
4KB
1KB
148
1KB
1KB
QKB
29KB
42 KB
1KB
1K8B
1KB

File Folder
File Foldar
File Folder
File Faldar
File Falder
File Folder
File Folder
File Folder
File Faldar
File Folder
File Folder
File Falder
File Folder
File Folder
File Folder
File Faldar
File Falder
File Folder
File Folder
File Folder
File Foldar
File Folder
File Folder
File Falder
File Folder
File Folder
File Folder
File Foldar
File Folder
File Folder
File Falder
BAK i
CDX File
DEF Fi:
FRT File
TEK File
DEF Fie
Icon

DIR File
applcation
Applcation

Shorkeut ko MS-DOS...

MS-DOS Batch File

Tcon

9/15/2003 12:47 PM
8/18/2003 3:32 P
9/15/2003 12:47 PM
8/4/2003 7:00 P
9/17/2003 9:29 A
9/15/2003 12:47 PM
9/15/2003 12:47 PM
8/4/2003 7:00 P
9[17/2003 9:23 AM
9/15/2003 12:47 PM
8/18/2003 3:32 P11
9/10/2003 11:41 AM
9/15/2003 9:04 AM
8/18/2003 3:32 M
9/15/2003 12:47 PM
8/18/2003 3:32 P11
8/18/2003 3:31 PM
9[L7/2003 9:14 AM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
8/19/2003 1:23 P11
9/12/2003 9:23 AM
8/4/2003 7:00 P
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 11:02 AM
9/15/2003 12:47 PM
8/4/2003 7:00 P
9/15/2003 12:47 PM
9/15/2003 12:47 PM
9/15/2003 12:47 PM
8/4/2003 7:00PM
4f22/2002 9:35 AM
8/4/2003 7:00PM
§(4/2003 7:00 P11
2/1/1993 2:04 AM
2/1/1993 2:04 A
8(4/2003 7:00PM
8/4/2003 7:00 M
8/4/2003 7:00 P

| Address [ CAUSRichadbF

Size |
File and Folder Tasks S
_ chgz-997, dbF 59 KB
) Make anew folder chg3-557.dbf i
&8 Publish this Folder to the
Chkdbf — Company check data. Chk-company#.dbf
| address [ cusricrroer
Mame = Size
File and Folder Tasks & = chi-000.06F 3 KB
_ chk-997.dbf 5 KB
B ke greitader =l MSCREATE.DIR 0 KB

&M Publish this Folder ta the

Cmpdbf — Company data. Cmp(year)-company#.dbf and cmp(year)-company.dbt

60



MasterLink user guide

| address [ CwsriCmPDEF

Mame = | Size | Tvpe |
File and Folder Tasks & = cropz-997.dbf SKE DEF File
. [ cmpz-097  dbt 1KE DET File
@.I' Renarne this file i SKE DB Fils
[ Move this file [ crp3-997 bt 1KE DETFile
[} Copy this file MPS-000.DBF 4KE DEFFile
&8 Publish this file to the Yireb CMPS-000.DET 1KE DBT Fils
= MSCREATE.DIR OKE DIR File

:j E-mail this file

Crystal — Crystal Report Writer Run Time Engine.

Custom — copy of most databases in MasterLink in a user friendly format. Used by
report generators like Crystal, Access, etc.

5 =8|
File Edt Yiew Favortes Tools Help ‘ o
@ Back = &) - ﬁ' 7 | Search | Folders
Adress [ GUSRicustam B> | Norton Antitirs £«
Mame - [ iz | Type | Date Modified -
File and Folder Tasks 2 THaciv.cox 3KB (DX Fis 9/17/2003 9:29 AW
" activ.DBF 1KB DEBFFiile 9/17/2003 3:20 AM
&9 Meke < iow Ikt [ sds.cox 3KB COXFie 9/17/2003 9:29 AM
[ ] S:'thh this folder ta the ada.DEF 7KB  DEF File 9/17/2003 9:29 A
P [ allergies.cox IKB CO%Fie 9/17/2003 3:29 A
|7 Share this folder
= sllergies.cF 1KB DBF File 9/17/2003 9:29 AP
= attn.cox 3KE COXFie 9/17/2003 3:20 AP
P » attn.DBF 1KB DEFFile 9/17/2003 9:29 AP
= charact.cox 3KE (O Fie 9/17/2003 9:29 AM
= Usk = charact.oeF 1KB DEFFile 9/17/2003 3:20 AM
) My Documents &l chk-997.08F 5KB DBF Flle 9/17/2003 9:29 AM
=) Shered Documents cobp.CDX 3K COMFile 9/17/2003 9:29 AM
3 My Computer B 1KB DBFFile 9/17/2003 3:29 A
= compens.cox 3KB COMFil 9/17/2003 9:29 AP
@ My hetwork Places = compens. oeF 1KE  DBF File 91712003 3:23 A
| depen.cox 3KB COFie 9/17/2003 3:29 A
e v [Edepenoer 2KE DBF Flle 9/17/2003 9:29 AM
| det3-997.co 4KB COXFie 9/17/2003 3:20 AM
| der3-997.dbF S8KB  DEF Flls 9/17/2003 9:29 AM
dot.COX 3K COMFile 9/17/2003 9:29 AM
| dot.0eF 1KB DBFFiile 9/17/2003 3:20 AP
[ edu.con 3KB COMFil 9/17/2003 9:29 AP
= edu.0er KB DEBFFile 9/17/2003 3:20 AP
[ emergency.cox 3KB COFie 9/17/2003 3:29 A
= emergency.oeF 2KE DBF Flle 9/17/2003 9:29 AM
EMp3-997.CDK 3KE COMFie 9/17/2003 3:20 AM
= emp3-997.08F 20KB  DBF Flle 9/17/2003 9:29 AM
EmpAutoTran.DEF 1KB DEF Fiile 9/17/2003 9:29 AM
= employmt.cox IKB COXFie 9/17/2003 3:20 AP
employmt.0BF 1KB DBF File 9/17/2003 9:29 AP
= empsaggr.cox 3KE (DX Fie 971712003 9:29 AP
emps3997.06F 21KB  DEF Flle 9/17/2003 3:29 A ..
[ hrjobs.cox 3KE COMFie 9/17/2003 9:29 AM
= hrjobs. oeF KB DEFFile 9/17/2003 3:20 AM
[Hfjinsurnee.cox 3KB COXFie 9/17/2003 9:29 AM
insurnce. DBF 1KB DEF File 9/17/2003 9:29 AM
[ job-s97.06F 3KB  DEF Flle 9/17/2003 3:20 AP
los.CDi 3KB COMFil 9/17/2003 9:29 AP
[ loa.08F 1KE DEFFile 971712003 9:29 AP
[Hlostype.cox 3KB COFie 9/17/2003 3:29 AM
[Hloatype.0BF 1KB DEF File 9/17/2003 9:29 AM
medevent.CDK 3KE COMFie 9/17/2003 3:20 AM
[ medevent.oer KB DBFFile 9/17/2003 9:29 AM
medication. CDi 3KE COMFile 9/17/2003 9:29 AM
[ medication.eF 1KB DBFFiile 9/17/2003 3:20 AP
Bl notes.cox 3KB COMFil 9/17/2003 9:29 AP
= rotes oeF 1KE DEFFile 971712003 9:29 AP
= pay-097.c0x 3KB COFie 9/17/2003 3:29 AM
= pay-597.dbi 6KE DEF Flle 9/17/2003 9:29 AM
praperty.cDX IKE COMFie 9/17/2003 3:20 AM
[ property.oer KB DBFFile 9/17/2003 9:29 AM

Most file names relate to the relevant screen in MasterLink.

[l el 207 v

KR (T File
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Detdbf — Check Detail file. Det(year)-company#.dbf. Contains all the transactions that

have taken place.

Address |5 C\USRIDETDEF

|7 Share this Falder

Fox — Program files

62

Marne  * I Size
File and Folder Tasks 2 detz-997.C0¥% 4 KB
, =) detz-997.dbf 76 KE
sk oo ok = det3-097.C0¥ 27 KB
@ Publish this folder to the det3-997.dbF 53 KE
\Web - ;
] Share this folder DZIEE;QDSDDEEF : E:
Ll FRac- f
| MSCREATE.DIR 0KE
Empdbf — Employee database. Emp(year)-company#.dbf.
| Address | C:\USRIEMPDEF
MName =~ | Size |
File and Folder Tasks S =l EMPO-000, DEF 47 KB
B =] emp2-997,.C0% 5 KB
J Make a new folder @ emp2-357. dbf b
&8 Publish this folder ta the B emp3-000, dbF | 47 KB
- ; | emmp3-997, C0% B KB
gt Share this folder emp3-99? b L
EMPE-000, C0% & kB
Other Places P 7| EMP6-000.DEF 47 KB
| MSCREATE.DIR akB
Fonts — MasterLink uses a number of fonts in Reports
Address |5 C\USRIFONTS
Marne  * I Size |
File and Folder Tasks & |micouR.Fot 2 KE
- peks ol IA] COURE.FOM 23 KE
G sk ooy Pk FOXPRINT.FOT 2 KE
€8 Publish this folder to the = MSCREATE. CIR 0 KE
‘Weh = }
L %) SAMEMONG, TTF 25 KB
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Wcusmrne o=l

Pl ER Vew Favrtes Tooh Mep L
Qe - ) - | s [ o | [T
L =] Eoo | morton zewwess L] -
e - Sien | Type | 1 =
File and Folder Tasks % Soevio.oe [ N 4% P
‘Hererann e Skn i f3zaz 11:50 Ak
() ake & ram Folder eS8 14KB DEFFis E4/2003 7:00 PH
Baﬂ"‘:"‘"l"*"""' ilmmlnnm SKB M S 7:00 b4
g PO JKD SPOno o ME-DOS... BN 111 PH
K s the flder [T Fossen pee 2KB DEFFR HZLIZ003 1237 PM
A FoaEER FRT 6KB FPTFie BITL2000 1:37 P
Uther Places & SFTFOATA.LAK 16D Dz Pl 03 7:00 P
[ fipdsta b LKD DOF Fie S/A072000 11:40 81
o R = T 1KB DBF Fis 1217R002 11:17 AM
() My Documents s 1KH DBF Fie {170 5T
3 Shared Documerts [ bk bF 2KD DOF Pl TR0 11117 A
B My Computer = 2K DEFFl TITIZ003 954 A
e cer 1KB DEFFie E12{20004:11 P
09 2yl s B rpbacki Cor TR0 GO Pl NS 1046 A
[Blnpbacks 06F KD DOF Fle S/15/2000 1047 A
Ceralls 3 Trchaiarer IKB DEFFie SISIZ003 10:48 4
= gtk D8R KR DEF Fie WIS 10:49 2
[ obachs.Cor TR0 U P SN 10:50 A4
=R 2K FRER FH{Z003 7:00 P
manchk MEM 1KB HEMFin 122003 10:10 24
MCWIAELG. DT SAKD Apskcation W03 7300 P
] 1D foon 42003 7:00 PH
[Hmocens con T T PHI{2003 12247 P
Amocens cer 1KB 06 e 1517003 17:47 P00
= MECREATL OB 0KD Uk W03 7500 P
S METRLKK] BV EKE  BRmap Inage HH/Z003 7:00 PH
morEs.coie IKB CTiFn BIO03 10:43 A1
E s oo SKD DA Pl SO0 1040 A4
Srasoer LKD DOF Fie LLL4T2000 L:14 P
= [T 1KB B Fie 003 7:00 PH
[P easwe. e WEKR L e SIS 12:47 B
B Passwo.cor TR OO Pl SN 1259 PH
‘T ParaLoe. B 2KB B Fie /003 7:00 PH
8 oy SKB DEFFie ITHI003 1T AN
SHFATHELF P 9KE el File seresing
[ payne 0 1KD D0 Pl BJ4/2003 7:16 P
WranewEes 3425KB  Applcation PIBIZ003 10:44 AM
Weamenor £ IATSER  Applcation RO 10:44 A4
B Fwrove,cor 1K OO P 10061957 2146 M
Slrcran.eE BKB Apgication BHIZ003 7:00 PH
Erezr e A2KB Agcication 193 204 AM
B nocess. o IKE DB Fie S07AFR00 2513 PH =
\SFRTRPT.LOF LKD  DOF Fie LT 124 P
HrEponrs.cox IKE CONFRe HEEII002 54T P
R reponrs o SKB DEF Pl wrajag 10
R SAILICO 1K feon W00 700 P
W] SANEMOND. TR 25K TrueType Fork fle 141935 900 AM
[ sekcrnmg HEM 1KB HEMFie WS008 1149 2
B staTEsurLCer IKH CEF Fie Ti0j L ST i
= Er KD DOF Pl 1252000 12:25PM
= 2un_ e Fae 116270000 1135 00 |

Key c:\usr\fox files
Payremot — MasterLink Executable file
Updtpay — MasterLink Update
Paynew — MasterLink new file
Foxrun — Dos program that unzips encrypted files. Must be set in command.com. In
win 98, command.com is in the root directory; in ME, 2k, NT command.com lives in
c:\winnt\system32\command.com. Verify this by going to Start, Search, Find files

GlIndbf — GIn(year)-company#.dbf. GL program databases.
| Address I[l__') CUSRalndbf

Mames =~ | Size
File and Folder Tasks Y alnZ-997,. 0k 25FKB
. ginz-997, dbF 113 KB
=9 Make Foold ;
B ake aiiew e gin3-997 . C0% 315 KB

Publish this Folder to the " :
L2 s =] ginz-997. dbF 149 KB

Hridbf — HR databases
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Address [ 5) C:\USRIHRIDER

Mame Size
File and Folder Tasks e [C2EHR000 ;
_JHR397
= Waks anew folder gHRB.ﬁ.SE
@ Publish this Folder o the [ HRRPT O 3 KR
Web = :
(27 sharethi o Chisig e
= :
| MSCREATE.DIR OKE
=
P A [Burotcustom.cox 3K8
| IPDTCUSTOM. DEF & kB

HRBASE - Contains all the HR databases.

Impdbf —MasterLink import data. Imp-company#.dbf and trn-company#.dbf. Imp-
company#.dbf is the import file structure for importing data, and trn-company#-dbf is the
translation table for the import file structure.

| Address I,_“] C:\UsRAimpdbf

_Name - | Size |
[E=in 1KB
55l brn-997 .DBF 1KE

File and Folder Tasks £

7 Make a new Folder

Inpdbf — Files sent to Service Bureau. Inp-company#.dbf - Input file. Inpm-
company#.dbf — temporary input file. Pass-company#.dbf — company identifier and
version #.  Itp-company#.dbf — temp file for check calculator.

Address |5 C:\USRIINPDBF

Mame = I Sizel
File and Folder Tasks ® =l hP-000.BAK 1 KB
= IP-000. DBF 1 KB
) Make faold
L Make anew foider [ inp-997 .D&F 4 KB
@ E‘-pL'EIL:Sh this Folder to the =5 mPm-oon.co & KE
k= Share this Folder = _INPM-DDD'DBF Lok
= inprn-297.cO 14 KB
=) inprn-997.0BF 4KB
Other Places S itp-957. DEF 1 KB
] MSCREATE.DIR 0 KB
i = = PAS-000,BAK 1 KB
i = Yot
[} My Documents =) 1 KB
[C7) Shared Documents = pas-997.dbf L KB

Jobdbf — company Job files. Comprised of three (3) levels. Job-(company#).dbf and job-
company#.cdx
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| Address | C:\USRII0BDEF

File and Folder Tasks ®

j Make a new Folder

@ Publish this Folder to the
Web

L7 share this Folder

Mame = Size
J0B-000.C0% 3KB
|4 308-000,DBF 3K8
job-297,.CD¥X 36 KB
job-a97. dbf 3KB
= MSCREATE.DIR KB

Lgodbf — company logo file to print on checks. Lg&(year)-company#.dbf and .cdx

| Address IL_"] CHUSRYIgodbF

File and Folder Tasks b

j Make a new Folder

@ Publish this Folder to the
Weh

Paydbf — company transaction code file. Pay-company#.dbf and .cdx

Mame =

[0 go2-957 .CD |
lgni2-997, dbF
lga3-997 0

lga3-997. dbf

| Address | C:\USRIPAYDEF

MName = Size |
File and Folder Tasks £ ] MSCREATE.DIR OkB
o P&Y-000.C0% 7KB
Iim Rename this file PAY-000,DBF 4 KB
[ Move this File pa-997, C0 38 KB
D Copy this file B 7.dbf 4]
LB Duklich Fhic Fila Fr Fhe sk
Payremot — System files.
| address [ ) CiusRipAYREMOT
Size
File and Folder Tasks b
= Make a new folder C0LUTROY
@ Publish this Folder to the [Ctmpaa?
web :
e =l CWFS0.FLL 56 KB
! Share this Folder INF‘ s L ¥E
m :
=] MSCREATE.DIR OkE
=l PAS. DEF 1KE

»

Other Places

Inp.dbf — backup input file

Pas.dbf — verifies MasterLink version, etc.

Ptm — ptm(year)-company#.dbf — Time card edit file
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| Address I.j C:\UsRAptmdbF

Size

File and Folder Tasks ES 1KB
Qd1dbf — QD(quarter)(year)-company#.dbf

Address | ) C:\USRIQDIDEF

Mame = Size

File and Folder Tasks & ]| MSCREATE.DIR OKB

= qd12-997.cox IKB

_’:} Make a new Folder %q i -

@ Publish this Falder to the qd13-097 CD;; 18 KB
‘Wehb ;

- _ ] qd1:53-097 . dbF 3KB

'l‘a? Share this Folder QDlEu-IZIIZIEI i e

QD1e-000.DBF 7 KB

First Quarter to date totals for the company by employee number
Qd2dbf, gd3dbf and gd4dbf are the subsequent quarter totals by employee
Reptxt — reportname.txt. Every time a report is run it is saved as reportname.txt.

Automatically over written when the report is re-run.
| Address I.j CHUSRrepkt

_Mame = | Size
File and Folder Tasks £ [Z]ideduction register bxt | 2 KB
E] employee history (dollars. bxt 6 KB
Make foold -
"3 5 ! ane.w oer |.'5] input repork Ext 3KB
@ E{;’:gsh this Falder to the E’l print gl reparts. bxt G KB
e . E_wl sick, & vacation report.bxk 115 KB
kol Share this Folder .
E’I tax repork.bxk 24 KB

Savemp — emp(company)-sequential number.dbf Backup of the employee file before the
received employee file overwrites the active employee database. Named sequentially up
to *9.dbf

| Address |_} CUSRisavemp

| Size I
File and Folder Tasks £ 492 KB
Sgndbf — sgn(year)-company#.dbf — Company check signature file.
| Address I.j C\USRsgndbf
Mames =~ | Size
File and Folder Tasks £ @ sg_2-997.pcl G KB
5 3-997.pcl B kB
J Make anew folder sg_z_gg? ECDX S
@ Publish this Folder ko the gn2—99?dbf 1KEB
[ o thifoker R o

Stxdbf stx(year)-company#.dbf Company State Tax file. Contains all of the individual
State Tax rules for every state the company is liable in.
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| Address |,_} C\USRYSTHDEF

MName =~ Size
File and Folder Tasks £ =] MSCREATE.DIR OKB
5| shxZ-097 Chix 3KB
= Make a new folder E i
@ Publish this Folder to the 2
LD 13 KE
e 3997, dbf 13 KB
_— 5] -7,
ket Share this folder = it
ST=6-000.0EF SKE

Svddbf — svd(year)-company#.dbf Global sick and vacation schedules
Address I’_} C:AUSR\svddbf

Marme I Size I
File and Folder Tasks 2 svd2-99?dhf 4KE
svd3-997. dbF 4KE

“4 Mazla o naw Faldar

Taxdbf — tax(year)-company#.dbf Company tax liability by pay day including gross
earnings
| Address | C:\USRITAXDEF

Mame = [ Size |
File and Folder Tasks S ] MSCREATE.DIR OKBE
_ tax2-997,COX 3KB
9 Waks anew folder ) £ 2 7-097 . dbf 19 KB
@ Ex?:II:ESh this Folder ko the Fax5-907.C0% 18 KB
e share this Folder tax?.f.?.?.?.:.'#.'f‘f._...‘_ 12k8
=T Axe-000,C0F | 3KB

=] TAxE-000.DBF KB

Ytddbf — ytd(year)-company#.dbf Company Year to Date totals by employee
| Address | ) C:\USRIYTDDEF

Marne =~ | Size |
File and Folder Tasks £ | MSCREATE.DIR OKB
F [ vedz-997.cox 3KB
Make Fold ;
B Pl aric e [ ytdz-a97.dbr 11 KB
@ Publish this Folder to the ytd3-997.COK 15 KB
‘Wb s
. : fi KB
bt Share this Folder 'f'TDE- — CDX 5 VB
m -000,
YTDE-000.DEF QKB
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